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Financials - 8.6 Release Notes (Mar. 29, 2017) 

Enhancements 
 

Accounts Payable 
• TRANSACTION INQUIRY: When selecting to include Credit Card Charges, there are now options to filter 

by Credit Card and Credit Card Users. 

 

Accounts Receivable 
• MODIFY ITEM INFORMATION: After changing the item description, you are now prompted to apply the 

description change to Recurring Charges. 

 

Bank Account Management 
• MODIFY > POSITIVE PAY LAYOUTS: A new Positive Pay Layouts page has been added. It allows you to 

add and modify Positive Pay layouts to meet the specifications of various banks. 

• MODIFY > BANK ACCOUNT INFORMATION > UPDATE:  If you mark a bank account that is used across 
multiple funds as Inactive, then the Reconciliation items from the newly marked inactive account are 
combined to the first active fund’s bank account. 

• ENTER > TRANSACTION: The description entered for a transaction is now assigned as the journal 
description when the transaction is posted. Previously, all transactions from Bank Account 
Management were assigned the journal description of “Bank Account Management Transactions”. 

 

General Ledger 
• ENTER > MANUAL JOURNAL: There is a new check box named “Create Reversing Journal in the Next 

Period?”. If you select this option, the program creates a reversing journal entry for the next period 
after you click the “Apply” or “Update” button. The reversing journal entry contains all the detail of the 
original entry except the debit and credit amounts are reversed. The journal and detail dates will 
assigned the first day of next month. 
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• REPORTS > FINANCIAL SPREADSHEET: An “Ending Period” drop-down has been added to the Options 
tab. This drop-down allows you to select the ending period for the report rather than using the period 
selected on the Current Financial Settings. 

• MODIFY > COMPANY INFORMATION: The option “Require the Posting Date and the Period to match on 
Sub Ledger Journals?” has been changed to “Require the Posting Date and the Period to match on all 
Journals?”. Selecting this option now requires not only Sub Ledger Journals, but also Manual Journals 
to have the Posting Date and the Period match. 

• REPORTS: The formatting of an exported CSV (comma delimited) file has been cleaned up for the 
following reports and their corresponding special reports: Statement of Financial Position, Budgeted 
Financial Statement, Designated Fund Summary, Financial Spreadsheet, Trial Balance Worksheet. 

• REPORTS > STATEMENT OF ACTIVITIES: A “Print by Project?” check box has been added and appears on 
the Filters tab if at least one project is assigned to a posted journal. This option allows you to select 
multiple projects to include on the report and displays the sum total of all selected projects on the 
report. 

• VIEW > POSTED JOURNALS: A “Show Summary Journal” check box has been added to the Filters area. 
Selecting this option lists each journal one time on the grid instead of listing each detail line for the 
journal. This new feature works best when filtering by Journal Types. 

 

Other 
• APPLICATIONS > SECURITY SETUP> TASK ROLES: Under the Bank Account Management application, 

there is now an option for “Update Finalized”. This option controls which users can edit or view a 
statement that has been finalized. 

• DASHBOARD > WIDGETS: The Bank Balances widget only displays Bank Accounts that the user has 
rights to view. (If the rights for a user are changed, then click the Refresh button on the widget to 
update the accounts that are displayed.) 

• HELP > TUTORIALS & VIDEOS: The Help files have been enhanced with new tutorials and videos. There 
are step-by-step tutorials that guide you through accomplishing essential tasks and answering 
frequently asked questions. Many of the tutorials also have accompanying videos. 
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Fixes 
 

Accounts Payable 
• ENTER > CREDIT CARD TRANSACTION: Fixed an error that would occur if you selected to enter a credit 

card transaction when there are no credit card users setup. 

• MANAGE > RECURRING PAYMENTS: The program has been modified so that when transferring 
recurring payments, the Due Date can be assigned a date that is prior to the current date. 

• REPORTS > 1099s: The Report Type “Create File for Electronic Submission” was putting a “P” in the 
sixth position of the Transmitter record. This has been corrected to be blank unless it is prior year 
information. 

• VIEW > TRANSACTION INQUIRY: The vendor field is no longer enabled when viewing the details of a 
Credit Card Transaction. 

• ENTER > TRANSACTION: Added pagination to the Link to Purchasing Management window in order to 
accommodate a larger amount of purchase orders. 

• MANAGE > PAYMENT PROCESSING: When processing payments for invoices that use Tax, Freight, or 
Other charges, the Bank Account item was displaying an incorrect amount. This has been fixed. 

• VENDOR SEARCH WINDOW: When searching for vendors, the sort was not working correctly for names 
containing all capital letters. For example, “Allen SMITH” was displayed after “Zach Smith”. This has 
been corrected and the names now sort properly regardless of the capital letters being used. 

 

Accounts Receivable 
• MANAGE > PAYMENT PROCESSING: The Payment field on the Miscellaneous Cash tab has been 

disabled since that amount should not be modified. 

• MANAGE > PAYMENT PROCESSING: The Payment Date is retained as the default for the next payment 
after clicking the Apply button. 

• MANAGE > RECURRING CHARGES: Recurring charges were listed multiple times in some cases 
depending on what was selected on the Items filter. This has been corrected. 

• REPORTS > MONTHLY STATEMENTS: When Accounts Receivable is set to run as Balance Forward, 
statements would include invoices paid outside of the date range in the payment due amount. This has 
been corrected. 
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• REPORTS > MONTHLY STATEMENTS: The option “Include Customer Name On Invoice Description?” has 
been added to the Options tab. 

• VIEW > TRANSACTION INQUIRY: The Transaction Inquiry grid no longer displays a number of “Days Past 
Due” for any invoices with status of 'Unposted' or 'Closed'. 

• UTILITIES > VOID PAYMENTS: The corresponding journal that is created when voiding an ACH Payment 
now handles the Debits and Credits properly so that the correct accounts are used. 

• UTILTIES > VOID PAYMENTS: An error was occurring when adding a payment to the grid if the Amount 
was incorrect. This has been fixed. 

 

Bank Account Management 
• MODIFY > BANK ACCOUNT INFORMATION: The “Company Extra Line” information located on the 

Company/Bank Info tab now prints on MICR checks if no images are used for the company. 

• BANK ACCOUNT INFORMATION: The delete icon no longer appears next to a bank account if it has a 
statement date created on the Manage > Bank Statements page. 

 

Fixed Assets 
• MODIFY > ASSET INFORMATION: The Retired Date has been fixed to work properly to filter assets. The 

Retired Date filter was also fixed to filter properly on the Selections and Listings page. 

 

General Ledger 
• MODIFY > BUDGET INFORMATION: The “Current Budget” link on the Budget grid has been fixed. 

Previously, it would not function correctly if there were multiple pages of budgets displaying. 

• UTILITIES > CLOSE FISCAL YEAR: The Fiscal Year Closing utility was modified so that it cannot be run 
unless you have full rights to all the accounts that have activity in that year. 

• REPORTS > BUDGETED FINANCIAL STATEMENT: The “Show Sub Accounts?” check box has been fixed to 
only show sub accounts when this option is selected. Previously, it showed sub accounts regardless of 
whether the check box was selected or not. 

• REPORTS > BUDGETED FINANCIAL STATEMENT: The report was improved to run faster. 

• REPORTS > DESIGNATED FUND SUMMARY: There was an issue where the Credits and YTD Credits were 
including amounts that should show on the Transfers & Adjustments column. This has been fixed. 
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• REPORTS > DETAIL LEDGER: Fixed an error that would occur if the Enter key was pressed after 
specifying an account. 

• REPORTS > JOURNAL HISTORY: Fixed an issue where the “Updated By” details would not display when 
selecting the “Show Setup Information?” check box. 

• REPORTS > PRELIMINARY BUDGET REPORT: Fixed an issue where the note information would not 
display when selecting the “Show Note Information?” check box. 

• REPORTS > STATEMENT OF ACTIVITIES: Fixed an issue that caused totals per level to show with no 
amounts. 

• REPORTS > STATEMENT OF FINANCIAL POSTION: Prior period figures are now displaying correctly. 

• SPECIAL REPORTS SETUP: The speed was improved when auto generating special report templates. 

 

Other 
• FINANCIALS: There was an issue where entering a number (#) character into an address line caused an 

error. This has been fixed. 

 

Pension Billing 
• MODIFY > ORGANIZATION INFORMATION: The Membership field is now limited to 9 characters. 

 

Purchasing Management 
• MANAGE > REQUESTS: The Print screen for requisitions now stays open in Chrome.  However, you may 

need to change the Pop up setting in Chrome.  In Chrome, go to Settings, Show advanced settings, and 
then click the Content settings button.  Under Pop-ups, either choose Allow all sites to show pop-ups, 
or choose Manage exceptions and add your Financials URL to the Allow list.  Exit Chrome and restart. 

 

Payroll 
• PAYROLL PROCESSING: An error no longer appears when editing an employee's time card if they have a 

deduction that is not subject to taxes set to “% net” and the employee has state and local/county tax 
tables on file. 
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• MANAGE > PAYROLL PROCESSING: Clicking the Finalize Post button multiple times no longer creates 
empty journal entries. 

• REPORTS > ACH PRENOTIFICATON: The ACH Prenotification file has been updated to include new 
transaction codes required by banks. 

• REPORTS > EMPLOYEE INFORMATION: When selecting the “Export to Excel?” option, the output file 
now has one line of information per employee and there was some cleanup done (merged cells, extra 
rows and columns). 

• UTILITIES > VOID CHECKS: The Void Check Edit Report and the Void Check Register was including non-
cash in the compensation total that caused the Net Total to be incorrect. This has been fixed. 
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Financials - 8.5.2 Release Notes (Jan. 30, 2017) 

Fixes 
 

Accounts Payable 
• REPORTS > 1099s: Fixed an error that was happening if you selected the “Create File for Electronic 

Submission” report type. 

• REPORTS > 1099s > Use E-File Service: If your company address has “Alabama” as the state, then the E-
File service no longer prompts for the State ID. This was changed to accommodate a unique 
requirement for the state of Alabama. 

 

General Ledger 
• UTILITIES > CLOSE FISCAL YEAR: Fixed a problem where duplicate account numbers would display on 

the Year End Closing Entries report in certain circumstances. 

 

Payroll 
• REPORTS > W2s: Fixed an error when selecting the report type “Create File for Electronic Submission” if 

an employee had two state tax tables and one local/county tax table. 
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Financials - 8.5.1 Release Notes (Jan. 3, 2017) 

Fixes 

General Ledger 
• REPORTS > BUDGETED FINANCIAL STATEMENT: Fixed issues where amounts were not showing for 

columns using formulas. Also, fixed an issue where the report was displaying a blank space instead of 
zeros when using the "Print Whole Dollars?" option. 

• REPORTS > FINANCIAL SPREADSHEET: Fixed an issue where the report was displaying a blank space 
instead of zeros when using the "Show Whole Dollars Only?" option. 

 

Payroll 
• MANAGE > PAYROLL PROCESSING: Fixed an issue that was causing the Check Date and Pay Period to 

not show on check stubs and vouchers. 

• DEDUCTION INFORMATION: Fixed an issue concerning the wage calculation when using the “% Net” 
option. 
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Financials - 8.5 Release Notes (Dec. 20, 2016) 

Enhancements 

Accounts Payable 
• ENTER TRANSACTIONS: The title and suffix now appear when vendors are listed on the Vendor Search 

window and on the Vendor Information page. 

• PAYMENT PROCESSING: The program now applies the Auto-Select setting when both selecting and 
deselecting a record. Previously, it was only being applied when selecting a record. 

Accounts Receivable 
• RECURRING CHARGES: Added the ability to create $0 recurring charges. (For example, a customer may 

have both a tuition charge and a scholarship for the same amount and thus yields a $0 recurring 
charge.) 

Bank Account Management 
• VIEW > ALL ITEMS: Added the ability to create $0 items in order to record voided and unissued checks. 

General Ledger 
• MODIFY > CHART OF ACCOUNTS: A Usage column has been added to the chart of accounts grid for 

each detail account. This feature gives you the ability to manage the same account across multiple 
levels (e.g. departments). Hover over the Information icon in this column to view information on how 
many times this account is used in other levels. Click the Information icon to view the Account Usage 
Detail window. This window allows you to see the where this account exists in other levels, displays the 
description, allows you to update the description, and gives you the ability to add this account to other 
levels.  

• REPORTS > BUDGETED FINANCIAL STATEMENT: The Budgeted Financial Statement now has an option 
that allows you to get totals across years for the YTD columns. This is the “Select Different Starting 
Period for Fiscal Year?” Check box. When checking this box, the Reporting Period drop-down changes 
to a Starting Period drop-down and allows you to select a year and period. The report uses the period 
specified on the Current Financial Settings as the ending period. This option does not show up if the 
user has the first year of the company selected under Current Financial Settings. This option is also 
available in Special Reports as well. Inactive accounts and accounts that don't exist in the current year 
but had data in any of the periods within the range selected, appear on the report. 
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Payroll 
• REPORTS > W2s: There is now an option to combine companies that have the same Federal Tax ID 

Number (EIN). 

• REPORTS > W2s: Added the ability to create a file for electronic submission of W-2's. 

• MODIFY > EMPLOYER INFORMATION: Added a “Print additional check stub info?” check box that allows 
you to print the company name, address, and current pay period on the check stubs. 

• MODIFY > EMPLOYEE INFORMATION: Added a warning message when adding any of the New York City 
tax tables if the employee makes $500,000 or more annually and is paid Monthly or less frequently. 

• MODIFY > COMPENSATION INFORMATION: When adding a new compensation type, “Box 7” is now 
available from the “Box # on W2” drop-down list. This can be used for recording Social Security tips for 
things such as church employees that are working at the church’s coffee bar. 

• MODIFY > DEDUCTION INFORMATION: Added a default deduction type for both Elective deferral Roth 
403(b) and Elective deferral Roth 401(k). 

• MODIFY > TAX TABLE INFORMATION: A County Code field was added to the Tax Table window for 
counties. This code appears in position 306-307 of the RS line when creating a W2 electronic file. 

Fixes 

Accounts Payable 
• MANAGE > UNPOSTED TRANSACTIONS: The “Download Positive Pay File” button has been added to 

the Finalize Post page when processing Quick Checks for a bank account that is marked to use Positive 
Pay. 

• MANAGE> PAYMENT PROCESSING: The word “Savings” has been removed from the total line on the 
ACH Verification Report. 

• VIEW > TRANSACTION INQUIRY: Fixed an issue where the Reprint Voucher option was not working 
properly in certain circumstances. 

• REPORTS > 1099s: Invoices that were undone, then re-posted and paid are now included on 1099’s. 

Accounts Receivable 
• REPORTS > PAYMENT REPORTS: Added a Statement report option that prints a summary for each 

vendor on a separate page so that the item totals are displayed for each item description. (This can be 
used for reporting childcare tax credits.) 
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General Ledger 
• REPORTS > STATEMENT OF FINANCIAL POSITION: Fixed the “Prior Month” and “YTD Prior” figures so 

that they include amounts from accounts that aren't part of the current year chart of accounts. 

Other 
• ATTACHMENTS: Attachments with file names that contain special characters can now be viewed 

without getting an error. (The program has been modified to allow the following special characters 
when naming attachment files: ~ ` ! @ # $ % ^ & ( - ) _ + = [ { } ] ; ' , ) 

Payroll 
• MANAGE > MANUAL CHECKS: The 'Manual Check Edit Report' and the 'Manual Check Register' now 

display the correct total of hours in the Final Totals section. 

• MANAGE > PAYROLL PROCESSING: Fixed the cursor action so that it highlights the hours when entering 
timecards. 

• MANAGE > PAYROLL PROCESSING: The Y-T-D Net amount is no longer including non-cash amounts 
when processing ACH vouchers. 

• MANAGE > PAYROLL PROCESSING: The ACH Verification Report, Payroll Voucher, & ACH File have been 
fixed to only show the account type that is being affected by the payroll. Zero amounts are not shown 
if the check amount is not large enough to be split between savings and checking accounts. 

• MANAGE > PAYROLL PROCESSING: The word “Savings” has been removed from the total line on the 
ACH Verification Report. 

• REPORTS > 941 SUMMARY: The “Deposits for Quarter” field has been renamed to “Calculated Deposits 
for Quarter”. The amount is now calculated instead of displaying the value from the previous period. 

• REPORTS > UNEPLOYMENT TAX REPORT: Added a Start Date and End Date to this report. 

• REPORTS > TIME OFF HOURS: The Summary line now shows information when processing the Time Off 
Hours report for a different start date than 1/1. 

• REPORTS > ACH PRENOTIFICATION REPORT: Modified the Account Type field to correctly display either 
“Savings” or “Checking” according to what is assigned on the employee’s record. Previously, the report 
was displaying “Savings” for all accounts. 

• UTILITIES > VOID CHECKS: Voiding checks now correctly resets any Time Off that was accrued by the 
check. 

• UTILITIES > VOID CHECKS: Users are now able to void ACH transactions even if they were processed on 
the same day, and they can void them in any order. 
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Financials - 8.4 Release Notes (Oct. 25, 2016) 
Enhancements 

Accounts Receivable 
• ITEM INFORMATION: The program now allows you to assign any account type (assets, liability, capital, 

income, and expense) instead of only income account types. 

• TRANSACTION INQUIRY: Added a “Print Labels” button so that labels can be printed based on the 
available filters.  

• COMPANY INFORMATION: Added the check box “Include Contract # on Invoice?” to this page. 
Selecting this option not only adds a Contract # field on the invoice entry page, but also adds a 
Contract # field for filtering and viewing invoices on the Transaction Inquiry page and adds a Contract # 
field on the Body tab of the Modify Statement Design page and Invoice Design page. 

General Ledger 
• REPORTS: Added the ability to search for accounts on the following reports: Special Reports Setup – 

Auto Generate, Budgeted Financial Statement, Chart of Accounts, Comparative Trial Balance, 
Designated Fund Summary, Detail Ledger, Financial Spreadsheet, Preliminary Budget, Statement of 
Activities, Trial Balance Worksheet. 

• COMPANY INFORMATION: Added the check box “Create Separate Bank Items for Each Detail Line?” to 
this page.  Select this option if you want to create a separate reconciliation item for each bank account 
detail line when a manual journal is posted. 

Payroll 
• REPORTS > 941 SUMMARY: Added the ability to run the 941 Summary report across multiple 

companies that share the same Federal Tax ID Number. 

• EMPLOYEE INFORMATION > UPDATE: A Marital Status field has been added to the Demographics tab. 

• COMPENSATION INFORMATION > UPDATE: Added the ability to assign Box 7 to compensations. The 
Box # on W2 drop-down now includes a “Box 7” option. 

• REPORTS > W2s: Added the option “Create File for Electronic Submission” on the Report Type drop-
down. 
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Portal 
• PORTAL:  Added an option to allow authorized users to assign General Ledger accounts and projects on 

requisitions created from the portal. Also, the budget information for the account displays. 

Purchasing Management 
• COMPANY INFORMATION: Added “Last PO# Used” and “Last Requisition# Used” fields so that the user 

is able to see a reference of this information. This field is not editable. 

Other 
• UTILITIES > ORGANIZATION: Added an “Include $ sign in reports?” option on the Default Settings tab. 

• GRIDS: The Select All check box located at the top of selectable grids was modified to select all records 
of the listing instead of just the currently viewed records. This is particularly helpful when you have 
more than one page of records listed on a grid and you want to select all the records on all the pages. 
The functionality also works the same when de-selecting records on a grid. 

 

Fixes 

Accounts Payable 
• TRANSACTION INQUIRY: The 1099 status now displays as a clickable link. Click the 1099 Status link to 

change the 1099 Status on a “quick-view” window. 

• VENDOR INFORMATION > UPDATE: The “Doing Business As” field on the Demographics tab is now 
available for organization records. Previously, this was only available on individual records. 

• REPORTS > 1099s: Added the option “Create File for Electronic Submission” on the Report Type drop-
down. 

• RECURRING PAYMENTS: After the Transfer Recurring Payments process is completed and then an EFT 
is changed to an Invoice, it doesn't show under Payment Processing. Made a change that fixes any 
transferred recurring payments that were changed from “EFT” to “Invoice” to display in Payment 
Processing so that they can be paid. 

• TRANSACTIONS > UPDATE: The Link to Purchasing Management window is now limited to show open 
PO's from the last 3 years. This speeds up processing time when entering transactions. 
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Accounts Receivable 
• PAYMENT PROCESSING: The calendar has been changed so that you can only select up to two years in 

the future. This aids in preventing payments from being saved with unrealistic future dates. 

Bank Account Management 
• RECONCILE BANK STATEMENT: Fixed an error when reconciling more than 5,000 items at one time. 

• RECONCILE BANK STATEMENT: The reconciliation report was modified to show all items that make up 
the outstanding items total. 

• RECONCILE BANK STATEMENT: Fixed a problem where the reconciliation was not tracked properly if 
two bank accounts were being reconciled at the same time. 

General Ledger 
• UNPOSTED JOURNALS: Fixed an issue where the date field was not wrapping properly on the Journal 

Edit and Posting List of Journal reports. 

• UNPOSTED JOURNALS: Fixed an issue where typing too quickly sometimes causes an issue with dollar 
amounts not being recognized. 

• POSTED JOURNALS: Changes have been made to speed up the View Posted Journals page for 
customers with many accounts in their Chart of Accounts or many projects. 

• POSTED JOURNALS: The Clear Filters link now properly clears all the filters on the Posted Journals page. 

• RECURRING JOURNALS: When posting recurring journals, the Posting Date field no longer appears on 
the Finalize page since the posting date is entered in the Date field on the Transfer Journal window. 

• UNPOSTED JOURNALS > IMPORT JOURNALS: Changed how the JournalNumber column functions in the 
Import Journals Excel file. It now functions by grouping together detail lines with the same journal 
number. The program assigns the next available journal number. In addition, the preview screen now 
shows the next available journal number. 

• UNPOSTED JOURNALS > UPDATE: Project codes entered on the detail lines of a journal are now 
validated. Prior to this change, the entry was updated and any invalid project codes were removed 
from the grid without warning. 

• POSTED JOURNALS: Fixed a timeout error that occurs with certain criteria specified. 

• CHART OF ACCOUNTS: When adding or editing an income or expense account, the Closing Accounts 
are now sorted by account number. 
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Loan Processing 
• REPORTS > 1098s: Added the ability to process 1098 and 1096 forms. 

• LOAN INFORMATION: A change was made to correctly calculate simple interest loans. 

• POST INVOICES: Updated the Post Invoices utility to allow multiple postings per month, allowing you to 
bring interest up to a certain date, like the end of the month. 

Payroll 
• CONTROL TABLE INFORMATION: The Workers Compensation “Rate” field has been increased to 

include 4 decimal places instead of 2. 

• EMPLOYEE INFORMATION > UPDATE: The Applied field in the Deduction Distribution section can now 
be edited. This allows the user to manipulate the deduction amounts applied against the pre-
established deduction limits. 

• REPORTS > 941 SUMMARY: The IRS Informational format no longer uses the required fields under the 
Other Information tab since those fields only apply to the IRS format. 

• REPORTS > 941 SUMMARY: There is now an informational icon next to the Number of Employees field 
explaining how this number gets calculated. 

• EMPLOYEE INFORMATION > UPDATE: Fixed an issue causing “Available Time Off” hours to be reset to 
the Maximum limit if the Available was greater than the Maximum. 

• REPORTS > ACA REPORTING: In the ACA form 1095-C, Box 15 prints 0.00 instead of .00. when using 
codes 1B, 1C, 1D and 1E. 

• REPORTS > ACA REPORTING: The Contact Telephone Number (Box 10) on form 1095-C now shows 
proper formatting. 

• REPORTS > ACA REPORTING: The 1095-C forms now appears in true alphabetical order regardless of 
the Home Department. 

• REPORTS > ACA REPORTING: The ACA website no longer requires a number of FTE Employee Count 
when using the 98% Offer Method under Certifications of Eligibility. 

• REPORTS > ACA REPORTING: The Social Security Number (box 2) on form 1095-C now shows proper 
formatting. 

Security 
• SECURITY SETUP > USERS: Errors no longer appear when trying to delete a user that has historical data. 
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Financials - 8.3 Release Notes (Sep. 1, 2016) 
Fixes 

General Ledger 
• ACCOUNT AMORTIZATION: Journal entries created when a user runs amortization no longer produce 

an error about debits and credits not matching per fund.  

• REPORTS > BUDGETED FINANCIAL STATEMENT: Opening and Ending balances now display properly 
when a user selects the option to “Include Opening and Ending Balance for Each Department.”  

• REPORTS > BUDGETED FINANCIAL STATEMENT: Header lines no longer show zero dollar amounts. 

• UNPOSTED JOURNALS: Users can now edit account numbers and amounts on journals that come from 
sub-ledgers as unbalanced.  

Payroll 
• PAYROLL PROCESSING: Journal entries created during payroll processing now properly include any 

projects assigned to compensation distributions on the employee record.  
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Financials - 8.2 Release Notes (Aug. 30, 2016) 
Enhancements 

Accounts Payable 
• MANAGE > UNPOSTED CREDIT CARD TRANSACTIONS: Users can now import credit card transactions 

using the “Import Credit Card Transactions” link.  The file needs to be in “.xls” or “.xlsx” format and 
imports into the company, year, and card selected under the Current Financial Settings. Transaction 
details can be viewed/edited before import. Once imported, transactions appear as unposted and an 
import report is displayed.  

Accounts Receivable 
• REPORTS > MONTHLY STATEMENTS: There is a new option to “Email Statements” on the Options tab of 

Monthly Statements. When this option is selected, the program emails PDF statements to customer 
records that have an email address and phone number. These PDF statements open using the last four 
digits of the customer’s primary phone number. 

Financials 
• UTILITY > EMAIL CONFIGURATION: Several fields have been re-labeled for clarity purposes.  

General 
• The program now keeps you logged in while on any update page. Update pages no longer time out due 

to inactivity. 

General Ledger 
• ENTER > MANUAL JOURNAL: You can now save “in-progress” journal entries that are incomplete/out of 

balance. Out of balance entries are marked “Pending” and a column has been added to the grid 
displaying which entries are pending. In addition, there is now a filter for “Pending” journals so you can 
view only pending or non-pending journals as desired.  

• REPORTS > DETAIL LEDGER: The option to page break by budgeted levels (e.g., Cost Center, 
Department) is now available on the Options tab of the Detail Ledger report.    

Purchasing Management 
• MOBILE PAGES: The login page, approval page, and rejection page have all been redesigned for a 

better mobile experience.  
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Fixes 

Accounts Payable 
• MANAGE > UNPOSTED TRANSACTIONS: ACH Information for an unposted transaction is now updated if 

the vendor on that transaction is changed.  

• MANAGE > PAYMENT PROCESSING: Names containing certain special characters (such as names with 
accent marks) no longer cause errors when printing MICR checks.  

• REPORTS > 1099s: The 1099 report now only includes paid invoices.  

Accounts Receivable 
• MANAGE > UNPOSTED INVOICES: ACH information for unposted invoices is now updated if the 

customer on that invoice is changed.  

• MODIFY > INVOICE/STATEMENT DESIGN: The “Legal” Paper Type now prints properly. 

Deposits on Hand 
• MODIFY > STATEMENT DESIGN: The “Legal” Paper Type now prints properly.  

General Ledger 
• MANAGE > UNPOSTED JOURNALS: The program no longer allows the posting of journals with no detail.  

• MODIFY > CHART OF ACCOUNTS: Fixed problem that caused certain sub-account groups not to display 
in the Chart of Accounts. 

• REPORTS > BUDGETED FINANCIAL STATEMENT: The Budgeted Financial Statement now shows all 
accounts that exist in the fiscal years on which you are reporting. Previously, only the current year 
accounts were shown.  

• REPORTS > DESIGNATED FUND SUMMARY: The Designated Fund Summary report no longer 
includes unposted journal amounts.  

Loan Processing 
• MANAGE > PAYMENT PROCESSING: Updating payments now creates accurate journals when Loan 

Processing is on an Accrual basis.  

• MANAGE > PAYMENT PROCESSING: Payments made towards loans that have not been invoiced are 
now creating accurate journal entries.  

• MANAGE > PAYMENT PROCESSING: The program now properly adjusts the “Interest Through” date 
and puts in an invoice “behind the scenes” when a user puts in a payment ahead of when invoices have 
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been posted for a loan. This prevents interest calculations from being incorrect for that loan going 
forward.  
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Financials - 8.1 Release Notes (June 30, 2016) 
Enhancements 

Purchasing Management 
• MANAGE > REQUEST: Users with full account rights are now able to edit requisitions without getting a 

message stating that they do not have rights to the accounts in the requisition.  
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Financials - 8.0 Release Notes (June 23, 2016) 
Enhancements 

Accounts Payable 
• The reprint voucher/check icon in Transaction Inquiry now displays in pre-printed check form even 

when Accounts Payable is set to use MICR checks.  

Accounts Receivable 
• There is now an option to print the Customer Number next to the name on Aging reports.  

• The “Check Date” field has been changed to “Payment Date” throughout Accounts Receivable.  

General Ledger 
• REPORTS: The Export to Excel option for the Budgeted Financial Statement, Financial Spreadsheet, and 

Statement of Financial Position reports now has improved formatting.   

• REPORTS > DETAIL LEDGER: There is now an option to suppress accounts with no activity in the 
selected date range or period. Users can also select to still display accounts with balances when 
choosing the previous option.  

Insurance Billing 
• The Insurance Billing module for Headquarters is now available. Insurance Billing allows your 

organization to manage insurance plans and send charges to Accounts Receivable.  

Payroll 
• REPORTS > 941 SUMMARY: The 2016 Form 941 now properly displays.  

Pension Billing 
• The Pension Billing module for Headquarters is now available. Pension Billing allows your organization 

to manage pension plans and send charges to Accounts Receivable. 

Portal 
• PURCHASING MANAGEMENT: Users can now enter Check Requests using the Portal.  

Security 
• PORTAL: All widgets for the financial modules now honor your task roles to determine whether or not 

they display.  
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Fixes 
 

Accounts Payable 
• CREDIT CARD RECONCILIATION: Credit Card Reconciliation now affects the correct funds when 

scheduling invoices and payments.   

• CREDIT CARD RECONCILIATION: Users can now reconcile credit card transactions that have been 
reversed, edited, and reposted. 

• CREDIT CARD TRANSACTIONS: Existing Purchase Orders not linked to General Ledger account numbers 
can now be linked to Accounts Payable transactions without generating an error.  

• CREDIT CARD TRANSACTIONS: Project codes are now brought over to detail lines when linking a 
Purchase Order to a credit card transaction.  

• PAYMENT PROCESSING: Multiple users can no longer select the same invoice to be paid. Invoices 
selected to be paid by someone other than the currently logged-in user are disabled for manual 
selection. Users can edit an invoice and override this on a per-invoice basis. 

• PAYMENT PROCESSING: Vendor names can no longer exceed 50 characters. This was done to prevent 
error 1812.  

• TRANSACTION INQUIRY: Project codes and 1099 status can now be edited and saved on any posted 
transactions through View > Transaction Inquiry.  

• TRANSACTIONS: Object error no longer occurs when a user clicks the “Link to Purchasing 
Management” button for vendors with POs that have no email address associated with the email 
originator.  

Bank Account Management 
• BANK ACCOUNT INFORMATION: Alphanumeric characters now properly display on the ACH Verification 

report and show up, as entered, within the Company/Batch Header Record in the ACH file.  

General Ledger 
• ACCOUNT STRUCTURE: Users can now delete funds in companies set up to use funds but not 

departments.  

• REPORTS > DESIGNATED FUND SUMMARY: When using ‘Transfer and Adjustment’ columns on the 
Designated Fund Summary report, the credit/debits and receipt/disbursements no longer reflect the 
adjustment figures.  
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Loan Processing 
• PAYMENT PROCESSING: Accurate journals are now created when a user updates payments and Loan 

Processing is on an Accrual Basis.  

• PAYMENT PROCESSING: Accurate journals are now created when a user updates a payment against a 
loan that has not been invoiced.  

Payroll 
• Bonus checks now properly increase the state tax basis when the compensation is subject to state 

wages and the employee has the state tax table on their individual record.  

• REPORTS > CALIFORNIA WAGE AND WITHHOLDING: The 2016 form now properly displays. In addition, 
an error no longer occurs if the company does not have a zip code extension.  

• REPORTS > EMPLOYEE EARNINGS: The Employee Earnings report no longer generates errors when a 
user attempts to export large amounts of data to Excel.  

• REPORTS > W2s: The appropriate forms are now provided when a user selects VI (for Virgin Islands) or 
GU (for Guam) in the Company Info. section.  

Portal 
• ACCOUNTS RECEIVABLE: Users can now process payments through the portal even if the revenue 

center is set up to accept only one payment method (Credit Cards or ACH).  

Purchasing Management 
• MANAGE > REQUESTS: Error no longer occurs when a user without rights to accounts being used on a 

purchase order attempts to open it.  

• MANAGE > REQUESTS: All detail lines now print when a user prints a purchase order containing a large 
number of detail lines. 

• MANAGE > REQUESTS: Account numbers are required for all detail lines before a requisition receives 
final approval.  

• MANAGE > REQUESTS: Users can now enter text in the ‘Reason’ field when rejecting a requisition.  

• WIDGET: The Purchasing Management widget now shows the correct number of requisitions. 

 


	Financials - 8.6 Release Notes (Mar. 29, 2017)
	Enhancements
	Accounts Payable
	Accounts Receivable
	Bank Account Management
	General Ledger
	Other

	Fixes
	Accounts Payable
	Accounts Receivable
	Bank Account Management
	Fixed Assets
	General Ledger
	Other
	Pension Billing
	Purchasing Management
	Payroll
	Financials - 8.5.2 Release Notes (Jan. 30, 2017)


	Fixes
	Accounts Payable
	General Ledger
	Payroll
	Financials - 8.5.1 Release Notes (Jan. 3, 2017)


	Fixes
	General Ledger
	Payroll
	Financials - 8.5 Release Notes (Dec. 20, 2016)


	Enhancements
	Accounts Payable
	Accounts Receivable
	Bank Account Management
	General Ledger
	Payroll

	Fixes
	Accounts Payable
	Accounts Receivable
	General Ledger
	Other
	Payroll

	Enhancements
	Accounts Receivable
	General Ledger
	Payroll
	Portal
	Purchasing Management
	Other

	Fixes
	Accounts Payable
	Accounts Receivable
	Bank Account Management
	General Ledger
	Loan Processing
	Payroll
	Security
	Financials - 8.3 Release Notes (Sep. 1, 2016)


	Fixes
	General Ledger
	Payroll
	Financials - 8.2 Release Notes (Aug. 30, 2016)


	Enhancements
	Accounts Payable
	Accounts Receivable
	Financials
	General
	General Ledger
	Purchasing Management

	Fixes
	Accounts Payable
	Accounts Receivable
	Deposits on Hand
	General Ledger
	Loan Processing
	Financials - 8.1 Release Notes (June 30, 2016)


	Enhancements
	Purchasing Management
	Financials - 8.0 Release Notes (June 23, 2016)


	Enhancements
	Accounts Payable
	Accounts Receivable
	General Ledger
	Insurance Billing
	Payroll
	Pension Billing
	Portal
	Security

	Fixes
	Accounts Payable
	Bank Account Management
	General Ledger
	Loan Processing
	Payroll
	Portal
	Purchasing Management


